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Introduction 

The financial officer is responsible for providing the returning officer (RO) and 
Elections Canada (EC) with reliable and consistent financial and operational 
documentation. 

The electoral period begins on Day 36 (at the latest), when the election is 
announced, and continues throughout the days leading up to Day 0, polling day.  

During an event, the office of the returning officer is the communications centre of 
the electoral district where the RO works with the public, election workers, landlords 
and other Elections Canada personnel. 

After polling day, the activity continues as financial processes are updated, 
reconciled and then submitted to Elections Canada for final payment.  

The Financial Officer’s Manual contains three parts: 

 Part 1 – Context: provides the information that the financial officer will need to 
complete his tasks. 

 Part 2 – Office Procedures: provides a step-by-step description of the tasks that 
need to be accomplished during an event. 

 Part 3 – References: provides useful information in tabular format.





    

 

Part 1 – Context 

This part of the Financial Officer’s Manual contains the following: 

 Chapter 1 – Financial References and Tools 

 Chapter 2 – Purchase and Rental of Goods and Services 

 Chapter 3 – Electoral Facilities and Polling Stations 

 Chapter 4 – Election Workers 

 Chapter 5 – Rules for Payment of Workers 

 Chapter 6 – Statutory Reports 
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Chapter 1 – Financial References and Tools 

1.1 Returning Office Payment System and SITES (ROPS/SITES)  

During an event, the Returning Office Payment System and SITES will be installed 
on a minimum of two computers in the office of the returning officer. The two 
computers will use a central database.  

At the beginning of the event, the RO will receive user names and passwords from 
Elections Canada. There are two ways of accessing the ROPS/SITES application: 

 using the SITES user ID and password; or 

 using the Finance user ID and password.  

As a financial officer, you will access the ROPS/SITES using the Finance user name 
and password. This will allow you to: 

 gather and enter payment information related to workers and landlords;  

 print reports, such as the Appointment and Oath form, polling site leases and 
statutory reports;  

 manage training sessions;  

 track hours worked by position;  

 update information on the accessibility of polling facilities;  

 electronically transfer the information required to process the payment of 
services and rentals.  

 

Once a payment has been confirmed by the RO in ROPS/SITES, it can no 
longer be modified. Accurate data capture is therefore essential. 

1.2 Finance Forms 

Paper Forms: These forms are delivered to the office of the returning officer in 
“Lot 11”.  

Electronic Forms: These forms are available in ECDocs.  

ROPS/SITES Forms: ROPS/SITES will produce the forms with all relevant 
information, providing the data has been captured.  

 

The table entitled R5 – Finance Forms at the end of this manual lists all the 
forms as well as their source. 
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1.3 Aide-Mémoire of Financial Activities 

At the start of an event, the Aide-Mémoire of Financial Activities (EC 11657) will be 
forwarded to each office. This aide-mémoire will assist the financial officer and the 
RO in their day-to-day financial tasks, with reminders of upcoming deadlines (e.g., 
end of pay periods) and important dates. This aide-mémoire should be consulted on 
a daily basis.  

1.4 The Federal Elections Fees Tariff 

It is this document that determines rates of pay and allowable expenses payable to 
all election workers. You can access this document through ECDocs, under the topic 
Canada Elections Act.  

 

Since the Federal Elections Fees Tariff does not provide for overtime pay, 
vacation pay, sick leave or statutory holiday pay for any position, election 
officers and office staff are not entitled to these types of benefits. 
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Chapter 2 – Purchase and Rental of Goods and 
Services  

2.1 Purchases and Rentals 

There are three methods of payment for goods and services that are purchased and 
rented: 

 the Elections Canada acquisition card;  

 accountable advances; 

 the Special Account Form (EC 11670). 

The RO is responsible for purchasing or renting certain goods and services, such as 
those listed in the R3 – Table of Expenditures at the end of this manual. The RO 
must:  

 record purchases according to detailed procedures; 

 verify that each expense is documented, complete and accurate; 

 sign each document to certify that it is correct. 

2.2 Taxes on Purchases and Rentals 

Federal Goods and Services Tax (GST) 

Elections Canada pays GST on all purchases and services. The supplier’s GST 
registration number must be on the invoice. If a supplier does not have a GST 
number, we do not pay the GST. 

Harmonized Sales Tax (HST) 

Elections Canada pays HST on all purchases and services in Newfoundland and 
Labrador, Nova Scotia and New Brunswick. The supplier’s HST registration number 
must appear on each invoice. If a supplier does not have an HST number, we do not 
pay the HST. 

Provincial and Territorial Sales Taxes (PST)  

Elections Canada does not pay PST. For proof of tax exemption, provide the supplier 
with the Sales and Consumption Taxes Exemption Certificate (EC 11650), available 
in ECDocs. 
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2.3 Authorized Methods of Payment  

Elections Canada Acquisition Card  

Elections Canada provides an acquisition card for the purchase and rental of goods 
and services required between and during electoral events. The Elections Canada 
acquisition card is the preferred method of payment as it allows faster access to 
goods and services, as well as simple and precise verification of expenditures.  

An acquisition card can be issued to the assistant returning officer (ARO) at the RO’s 
request; however, the RO remains responsible for its use and for the approval of all 
expenses through the monthly reconciliation.  

Accountable Advance for Petty Cash  

The RO will also receive an accountable advance from Elections Canada that is to 
be used for a petty cash fund. Petty cash expenses must be for less than $200 each. 
Petty cash can be used for expenses, such as those listed in the R3 – Table of 
Expenditures at the end of this manual.  

The allowable kilometre expenses for training and service are not paid from petty 
cash but are recorded and paid through ROPS/SITES.  

 

Petty cash must never be used to pay workers or to reimburse individuals 
or groups hired to affix labels. 

Petty cash must never be used to pay for food or drinks. The only exception 
to this rule is that of the candidates meeting, in which limited beverages and 
food may be served. 

Whenever possible, the acquisition card should be used for purchases or rentals, as 
it is a more efficient process to manage. 

Accountable Advance for Temporary Help 

The accountable advance for temporary support staff is to be used only to 
compensate groups, such as girl guides, boy scouts, hospital auxiliaries, etc. for 
affixing labels on the Voter Information Cards. Payment must be made to the group, 
not to individuals. The maximum payable to any group is $500.00. This advance 
cannot be replenished.  

Special Account Form (EC 11670) 

This form is used when it is not possible to use the acquisition card, an accountable 
advance or ROPS/SITES to buy or rent goods and services. These expenses will be 
paid directly by Elections Canada. 
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Chapter 3 – Electoral Facilities and Polling Stations  

3.1 Electoral Facilities  

During an event, returning officers will use many types of electoral facilities: 

 the office of the returning officer, as well as the office of the additional assistant 
returning officer where applicable;  

 polling sites (used for ordinary, advance and mobile polls);  

 offices used for revision.  

The ROPS/SITES application will contain information on polling sites and offices 
used for revision.  

3.2 Rental of Offices for the RO and AARO  

Because the lease will have been pre-approved, rental information related to the 
offices of the RO and AARO will not be recorded in ROPS/SITES. Elections Canada 
will pay the landlord directly: 

 1st payment within 10 days of Elections Canada receiving the lease signed by the 
RO and the landlord; 

 2nd payment within two days of vacating the premises.  

 

Please remember that the GST number must be written on each lease to 
allow EC to pay the landlord the GST. 

3.3 Lease Agreement for Polling Sites  

Confirm Polling and Revision Sites 

As soon as an election is called, it is essential that someone contact the landlord to 
confirm that his building is still available as a polling site or revisal office. Once verbal 
confirmation has been obtained, ROPS/SITES must be updated to allow: 

 the production of lease contracts that ensure that sites will be available for polling 
day; 

 the production of Voter Information Cards; 

 the automated transfer of data required by the Enquiries Unit in Ottawa to answer 
the question “Where do I vote?”; 

 the assignment of workers to the office or polling site. 

In rare cases, information on a polling site location should not be provided to electors 
who call Elections Canada. To block access to Elections Canada in Ottawa, clear the 
Release to ECHQ flag on the Assignment tab.  
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ROPS/SITES details related to polling sites must be verified before Voter 
Information Cards are produced on Day 30. 

Lease Agreement for Polling Sites  

The Standard Contract of Lease (EC 11750) must be verified in ROPS/SITES, and 
then printed for the signature of the RO and landlord.  

Each landlord will receive a lease contract that includes: 

 every site that the landlord intends to lease to the returning officer; 

 a list of polling stations at each site; 

 a list of registration desks and revisal offices, where applicable; 

 the total payment due to the landlord.  

At the end of the event, all lease agreements must be returned to Elections Canada 
in a package addressed to the Electoral Financing Division. 

Increases in the Amount Prescribed in the Federal Elections Fees Tariff 

Occasionally, landlords will request a rental fee that is higher than the amount 
prescribed in the Federal Elections Fees Tariff. These increases must be approved 
by the Chief Electoral Officer. To request this approval: 

1. Provide justification for landlord’s request using the RO Special Request 
(EC 10326). 

2. Ask the RO to sign the request, then fax it to Electoral Coordination. 

If the request is authorized, the RO will receive a Control of Authorization (COA) 
number. This number must be entered in ROPS/SITES, along with the authorized 
amount. This procedure is described in Part 2 – Office Procedures of this manual. 

Payments for the Rental of Polling and Revision Sites  

Information related to the payment of polling stations must be sent to Elections 
Canada only once, within the four days following the vote. After polling day, 
landlords will receive a single payment for all the facilities that they rented.  

 

In the case of polling sites, the landlord will be paid only for polling stations 
and registration offices where workers were assigned. 

Once the payment file has been confirmed by the RO in ROPS/SITES, it can no 
longer be modified. It is therefore crucial that verification of data entry be performed 
before this confirmation occurs.  
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Chapter 4 – Election Workers 

4.1 Election Workers 

All workers with the exception of the RO and the ARO must be registered in 
ROPS/SITES. The RO and the ARO are paid automatically by Elections Canada; 
therefore, no additional documentation is required from them during an event. 

ROPS/SITES places workers into two categories: 

 office workers who work throughout the electoral period; 

 poll officials who work on ordinary polling day and at advance polls. 

For the list of workers in each category, please refer to the R2 – Table of Election 
Workers at the end of this manual. 

Each office worker, regardless of category, must swear and sign an appointment and 
oath form. These forms are generated by ROPS/SITES and contain information 
relevant to the position and assignment of the workers. 

Personal information for all workers who were involved in the last election will be 
downloaded automatically when ROPS/SITES is installed in the office of the 
returning officer. It is very important to double check and update this information and 
to delete the names of persons who will not be working at this event. By reducing the 
amount of information in ROPS/SITES, searches will be more efficient and higher 
quality data will be saved during the decommissioning process. 

 

A worker can be registered in ROPS/SITES without entering a Social 
Insurance Number (SIN) immediately. The worker’s Appointment and Oath 
form can also be printed without a SIN. However, you will require a valid SIN 
to create a time sheet or process any other expense for that worker. 

4.2 Choice of Method of Payment 

All workers should be encouraged to use the direct deposit method for receipt of 
payment. Direct deposit is safe, convenient and quicker than payment by cheque.  

Direct Deposit into a Chequing Account 

The worker must provide a voided personal cheque that provides the necessary 
banking information. After entering the banking information into ROPS/SITES, retain 
the voided cheque in the personnel files along with the oath forms. 
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Here is a sample of a voided cheque. The numbers at the bottom are always 
sequenced in that order and hold a specific meaning. In this example: 

 123: Always at the beginning of the sequence, it represents the cheque number, 
which is not to be entered in the system. 

 45678: Represents the Branch No. (always 5 digits) and needs to be captured in 
the system. 

 003: Represents the Financial Institution identifier (always 3 digits) and needs 
to be captured in the system. 

 9999…: Represents the Account Number (up to 15 digits) and needs to be 
captured in the system. 

 
The fields in ROPS/SITES do not appear in this order. Be vigilant! 

 

 

Person’s Name  
and Address 

 Cheque no. 123 
 

 

Pay to V O I D 

 

 

  $ 
 

 

Name and Address  
of the financial institution  

 
No signature 

 

     

 

    ’123’ :45678’’003’: 999999999999999 
 

      

Branch No.   Account No. 
 

 

Financial Institution  
 

Direct Deposit into a Non-Chequing Account  

If a worker wants his pay deposited into a non-chequing account, he must ask his 
bank for a printout of his banking information. This is done to ensure accuracy of the 
direct deposit data. Do not accept handwritten banking information, unless it is 
entered on a bank form and signed by an official from the bank. Once the banking 
information is provided, enter the required information into ROPS/SITES. 
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Payment by Cheque 

If a worker does not choose the direct deposit option, Elections Canada will mail the 
pay cheque to the worker’s home address on the same day that direct deposits take 
place. Consequently, the cheque will arrive a few days after payment by direct 
deposit.  

In this case, do not enter any information for direct deposit into ROPS/SITES. 

Pay Statements 

Pay statements are mailed every two weeks to office staff and only once to polling 
day workers. The statements are mailed from Ottawa, and include details of hours 
worked, rate of pay and deductions, if any. These statement stubs are attached to 
payments made by cheque or are mailed separately for payments deposited directly 
into the worker’s bank account. 

4.3 Personal Information of Employees Entered in ROPS/SITES 

All information relating to the recruitment, hiring and payment of workers registered 
in ROPS/SITES must be kept by the RO. This information is not returned to Elections 
Canada. 

4.4 Rates of Pay for Election Workers 

In order to pay the persons registered in ROPS/SITES, a time sheet must be 
generated and confirmed in the system. The way of doing so in ROPS/SITES will 
vary according to the type of position. You will either have to: 

 Transcribe the data from the Time Sheet for the Election Worker (EC 11655) that 
has been filled in by the worker and authorized by the RO; 

or 

 Verify the time sheets generated automatically by ROPS/SITES;  

or 

 Enter a predetermined number of hours in order to ensure that the worker is paid 
the prescribed amount for his work. 

Positions with Hourly Rates of Pay 

All staff in positions paid by the hour must complete the Time Sheet for the Election 
Worker on a daily basis. For the list of workers who must complete a time sheet, 
please refer to the R2 – Table of Election Workers at the end of this manual. 

The Time Sheet for the Election Worker is an E-Form that can also be printed and 
filled in by hand.  

A person may be working in more than one position. In this case, the worker keeps 
track of the hours worked for each position on the time sheet, which provides two 
lines for each day for this reason.  
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1. The worker fills in and signs the time sheet. 

2. The time sheet is then submitted to the RO for certification. 

3. The financial officer ensures that the RO has certified that the time sheets are 
complete and correct. 

4. A copy of this certified time sheet is provided to the individual. 

5. Keep the original time sheet filed at the office of the returning officer for future 
reference. 

Positions with Fixed Rates of Pay 

Some positions receive a set fee prescribed by the Federal Elections Fees Tariff. 
Although workers in these positions do not have to fill out a time sheet, the 
associated information must be entered in ROPS/SITES to ensure that workers in 
these positions are paid. 

AC, AAC and AARO(s) 

The automation coordinator, assistant automation coordinator and additional 
assistant returning officer(s) receive a set fee for the entire election period, as 
prescribed by the Federal Elections Fees Tariff, regardless of the number of hours 
that they work. In order to distribute their pay equally, a predefined number of hours 
must be entered in ROPS/SITES at the end of each pay period. 

The number of hours to be entered is listed in the Aide-mémoire of Financial 
Activities that is sent to the RO when the office opens. This number of hours ensures 
that payments conform to the amounts prescribed in the Federal Elections Fees 
Tariff. 

Deputy Returning Officers, Poll Clerks and Personnel on Standby  

Poll clerks, DROs and personnel on standby, whether they are assigned to ordinary 
polls or advance polls, are paid set fees. To ensure that payments conform to the 
amounts prescribed in the Federal Elections Fees Tariff, their hours worked are 
automatically entered in ROPS/SITES. However, you should verify that the system 
has properly generated the time sheet. 

Position 
Number of Hours Automatically Entered in ROPS/SITES 

Ordinary Polls Advance Polls 

DROs and Poll Clerks 14 28 

Personnel on Standby 2 6 
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4.5 Other Election Worker Payments Entered in ROPS/SITES 

Training Fees 

For the list of workers who are entitled to receive the training fee, please refer to the 
R2 – Table of Election Workers at the end of this manual.  

When the training is over, workers’ participation must be recorded in ROPS/SITES to 
ensure that the associated training fee gets paid.  

 For office staff, this payment will take place after confirmation of the next pay 
period. 

 For poll officials, both ordinary and advance polls, this payment will take place 
after confirmation of their pay, after polling day. 

Training-Related Travel Allowance  

The training fee includes an allowance for 35 km of travel to and from the training 
session.  

If a worker must travel more than 35 km in his own vehicle to attend training, the 
worker is reimbursed for the number of kilometres over 35. 

1. The worker completes the electronic form Kilometre Log (EC 11700). Travel 
kilometres are paid according to the Rates for Travel and Living Expenses 
(EC 09600). 

2. The RO verifies the worker’s Kilometre Log and signs it.  

3. You must enter the total kilometres travelled on the Other Payments tab in 
ROPS/SITES. 

 

ROPS/SITES will subtract the first 35 km when processing the payment 
amount, so it is important that you enter the total number of kilometres 
travelled. 

Until the worker’s attendance at training has been recorded in ROPS/SITES, 
you will be unable to enter training-related kilometres. 
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Travel Expenses Not Related to Training 

For the list of workers who are entitled to receive reimbursement for travel kilometres 
not related to training, please refer to the R2 – Table of Election Workers at the end 
of this manual.  

 

Under no circumstances is gas money to be given to workers. They will be 
paid for kilometres through ROPS/SITES. 

Some positions require that incumbents travel to perform their duties during an 
event. Workers in those positions who use their own vehicle will be reimbursed for 
the total number of kilometres travelled.  

These are the steps involved in processing a claim for reimbursement of authorized 
travel kilometres: 

1. The worker completes the electronic form Kilometre Log. Travel kilometres are 
paid according to the Rates for Travel and Living Expenses. 

2. The RO verifies the worker’s travel claim and signs it.  

3. You must enter the total kilometres travelled on the Other Payments tab in 
ROPS/SITES. 

Only authorized km expenses are paid through ROPS/SITES. All other travel 
expenses must be submitted by other means (see the next section). 

4.6 Other Election Worker Payments Not Entered in ROPS/SITES 

Travel and Living Expenses Not Entered in ROPS/SITES 

Before any travel (other than travel taking place in the normal course of an event) 
occurs, prior authorization must be obtained from Electoral Coordination.  

To request payment related to this type of travel: 

1. Send the following documents to Electoral Financing by Priority Courier: 

 the document from Electoral Coordination authorizing the travel; 

 the travel forms filled out by the traveler and signed by the RO; 

 original receipts for all expenses except meals. 

2. Retain a copy of these documents in the employee’s files. 
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Cell Phone Use  

The RO can ask certain workers to use their cell phone for electoral purposes on 
polling day. In order to pay the associated $25 allowance, you may choose either of 
the following two methods: 

Method Description 

Petty Cash In exchange for cash payment, you must obtain a proof of payment that 
includes: 

 the date; 

 the amount paid; 

 the name and signature of the worker stating that the payment has 
been received for use of a cellular telephone for electoral purposes; 

 the SIN and full address of the worker. 

Special Account 
Form 
(EC 11670) 

For Elections Canada to pay the allowance directly to the workers, the 
Special Account Form must contain the following details: 

 a statement that the allowance is related to the use of a cellular 
telephone for electoral purposes; 

 the name, SIN, address and amount to be paid to each worker; 

 the form must be signed by the RO before it is sent to Electoral 
Financing by Priority Courier.  

4.7 Pay Periods 

Office Staff Pay Periods  

In a 36-day calendar, there are three predetermined pay periods of two weeks each 
for office staff. Each two-week pay period begins on Sunday and ends on Saturday.  

To ensure timely payment, time sheets and other claims must be submitted through 
ROPS/SITES to Elections Canada on the day that the pay period ends or on the next 
day. The Payment Authorization Report produced by ROPS/SITES must be signed 
by the RO and faxed to Electoral Financing. There is nothing to send by mail. 

Pay Period End of Pay Period Last day to confirm the pay 

1
st
 Pay Period Day 23 Day 22 

2
nd

 Pay Period Day 9 Day 8 

3
rd

 Pay Period Day –5 Day –6 
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Pay Period for Polling Day Workers  

Information relating to the payment of poll officials (ordinary and advance polls) is 
submitted to Elections Canada only once, via ROPS/SITES, no later than four days 
after polling day.  

Once a payment has been confirmed by the RO in ROPS/SITES, it can no 
longer be modified. Accurate data capture is therefore essential before performing 
the final confirmation. 
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Chapter 5 – Rules for Payment of Workers 

Source deductions include: 

 deductions for federal and provincial income tax; 

 Employment Insurance (EI) premiums; 

 contributions to Canada Pension Plan (CPP) or to the Québec Pension Plan 
(QPP). 

5.1 Thirty-Five Hour Rule for CPP, QPP and EI  

Individuals who work 35 hours or more during an electoral event are subject to 
deductions of CPP, QPP and EI from their earnings.  

 All office staff members are presumed to work 35 hours or more during the event 
and are automatically subject to federal and provincial income tax, CPP/QPP 
source deductions and deduction of EI premiums. 

 If an office staff member works less than 35 hours, CPP/QPP and EI deductions 
previously taken from their pay are reimbursed post-event. Federal and provincial 
income tax will not be refunded and will appear on T4 and Relevé 1 slips. 

 Any office staff member who also works as a poll official will be subject to source 
deductions.  

 Poll officials who work less than 35 hours at advance or ordinary polls will not be 
subject to source deductions.  

5.2 Federal and Provincial Income Tax 

Income tax, both federal and provincial, is calculated according to the applicable 
minimum in the province where the person is working. Deductions will be made for 
the following worker categories: 

 office workers;  

 office workers who also work on polling day; 

 poll officials who work at advance polls and on ordinary polling day.  

No tax will be withheld from poll officials who work only at advance polls or on 
ordinary polling day because their income does not exceed the federal or provincial 
tax minimum.  

 

All income is subject to tax, even if taxes have not been withheld. All workers 
must declare this revenue in their annual income tax return. 
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Tax Credits 

Deductions for federal and provincial taxes automatically default to the basic 
personal exemption, except if an individual has additional federal or provincial tax 
credits.  

If a person has additional credits, at the start of the event he must complete the 
following form(s), which are kept at the RO’s office: 

 Canada Revenue Agency Personal Tax Credits Return (TD1), to change the 
basic federal tax deduction;  

 the provincial Personal Tax Credits Return, to change the basic provincial tax 
deduction. 

 

Requests to withhold additional federal or provincial income tax deductions 
cannot be accepted. 

5.3 Canada Pension Plan (CPP) 

The Canada Pension Plan (CPP) deduction is mandatory for all workers between 18 
and 70 years of age who work 35 hours or more during an event.  

 Individuals under 18 and over 70 years of age are exempt from CPP deductions. 
They must provide proof of their date of birth. 

 Individuals under 70 years of age who receive CPP benefits are exempt from 
CPP deductions providing they submit one of the following documents to the RO: 

 a CPP benefits stub;  

 T4-P; or 

 a letter of entitlement from Health Canada. 

Keep a copy of proof of benefits and proof of date of birth at the office of the 
returning officer. 

 

The exempt CPP box must be checked for the exemption to take effect in 
ROPS/SITES. 

5.4 Québec Pension Plan (QPP) 

The Québec Pension Plan (QPP) deduction is mandatory for all workers in Québec 
who work 35 hours or more during an event. There are no exemptions to this rule.  

5.5 Employment Insurance (EI)  

EI premiums are paid by all employees of every age who work 35 hours or more 
during an event. There are no exemptions to this rule.  
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5.6 Source Deductions Summary Table 

Worker Category  
Office Worker 
(RO or AARO 

Office) 

Advance 
Polls 

Polling 
Day 

Assigned to more 
than one position 

35 hours? YES 
1
 NO NO YES 

1
 

Income Tax YES NO NO YES 

EI 
YES 

1
 – regardless 
of age 

NO NO 
YES 

1 
– regardless of 

age 

CPP 
(outside Québec) 

YES 
1 
– between 

18 and 70 years of 
age

2
 

NO NO 
YES 

1 
– between 18 

and 70 years of age
2
 

QPP 
(Québec) 

YES 
1 
– regardless 
of age 

NO NO 
YES 

1 
– regardless of 

age 

1 If the 35-hour minimum is not reached as planned, deductions (EI, CPP/QPP) will be 

reimbursed to the workers at the end of the event. 
2 Workers under 70 years of age who wish to claim an exemption must present proof that 

they are receiving CPP benefits. 
 

 
Income tax deductions will not be reimbursed! 

5.7 T4 Slips 

Elections Canada issues T4 slips to:  

 all workers who earned $500 or more; and  

 all workers who had source deductions applied to their earnings, regardless of 
the total amount earned.  

The T4 is mailed to a worker’s home address before the employer deadline of 
February 28 of the following year. It accounts for all income paid between January 1 
and December 31 of the previous year. 

 

At the end of the year, each worker must declare his income, whether or not 
a T4 slip has been issued. 
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5.8 Relevé 1 Slip 

Elections Canada issues a Relevé 1 to each election worker in the province of 
Québec, regardless of the amount earned. The Relevé 1 is mailed to the worker’s 
home address before the employer deadline of February 28 of the following year. It 
accounts for all income paid between January 1 and December 31 of the previous 
year.  

5.9 Record of Employment 

Elections Canada issues a Record of Employment to those who have worked 
35 hours or more during the event and have contributed Employment Insurance 
premiums. The Record of Employment is mailed to the worker’s home address 8 to 
10 weeks after the event. 
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Chapter 6 – Statutory Reports 

The ROPS/SITES application allows users to produce statutory reports in full or in 
part. The accuracy of these reports depends entirely on the quality of the data entry. 
Consequently, before producing a report, ensure that data entry is complete and 
accurate.  

To access the statutory reports in ROPS/SITES: 

 On the Reports menu, point to Statutory Reports, and then click the specific 
report.  

6.1 Report Preparation Calendar 

 Day 29: prepare for distribution the list of revising agents. In ROPS/SITES, see 
the Revising Agents report. 

 Day 18: prepare the attachment for the Notice of Grant of a Poll (EC 10170). In 
ROPS/SITES, see the List of Polling Sites (Condensed) report. 

 Day 18: prepare the Notice of Advance Poll (EC 10140). In ROPS/SITES, see 
the Notice of Advance Polls report. 

 Day 15: prepare the Notice of Mobile Poll (EC 10160). In ROPS/SITES, see the 
Notice of a Mobile Poll report. 

 Day 3: prepare for posting the List of Officers (EC 10290) for DRO and poll clerks 
who worked during the advance poll or who will work on ordinary polling day. In 
ROPS/SITES, see the DRO/Poll Clerks – Advance Poll and DRO/Poll Clerks – 
Ordinary Poll reports. 





    

 

Part 2 – Office Procedures 

This part of the Financial Officer’s Manual contains the following: 

 Procedure 1 – Processing of Lease Agreements 

 Procedure 2 – Recruitment of Personnel and Registration in ROPS/SITES 

 Procedure 3 – Staff Training 

 Procedure 4 – Management of Budgeted Hours in ROPS/SITES 

 Procedure 5 – Confirmation of Polling Day Activities  

 Procedure 6 – Finalizing Payments in ROPS/SITES 

 Procedure 7 – Administration of Purchases 

 Procedure 8 – ROPS/SITES Decommissioning 
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Procedure 1 – Processing of Lease Agreements 

P1.1 RO or AARO Office Lease 

The leases for the RO or AARO offices are not processed in ROPS/SITES. The 
following steps should be executed as soon as the writ is issued: 

1. Print the electronic lease agreement that was supplied to the RO during 
pre-event and fill it. 

2. Ask the landlord to sign the lease. 

3. Have the lease signed by the RO. 

4. Make a copy of the signed lease for the RO’s files. 

5. Fax the signed lease to Electoral Financing.  

6. Send the original lease on the same day by Priority Courier to Electoral 
Financing. 

 

The lease agreements for the RO and AARO offices are not recorded in 
ROPS/SITES. 

P1.2 Leases for Polling Sites and Offices Used for Revision 

Confirm the Use of a Polling Site or Revisal Office 

When an election is called and as soon as the landlord verbally confirms the use of 
one or more polling sites, update ROPS/SITES as follows: 

1. Access the Landlord module in ROPS/SITES. 

2. On the Selection tab, select the landlord. 

3. On the Facilities tab, select the appropriate facility. 

4. On the Facility Details tab, click the Assignments tab. 

a) Click Assign Polling Stations to display the list of polling stations that are 
not yet assigned. 

b) Select the polling station numbers that you wish to update. 

c) Click OK.  

5. If specific rooms within a polling site had been previously identified, the Voting 
Rooms tab becomes active. Select the location of the polling station. 
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Increase the Amount Set by the Federal Elections Fees Tariff 

When the RO receives authorization for an increased rental amount for a polling site, 
enter the Control of Authorization (COA) number and the authorized amount in 
ROPS/SITES:  

1. Access the Landlord module in ROPS/SITES. 

2. On the Selection tab, select the landlord. 

3. Click the Facility Details tab. 

4. For the relevant polling site: 

a) On the Assignment tab, select the appropriate box in the Override Fee 
column for each polling station involved. 

b) Enter the new amount in the Amount column and the COA number in the 
corresponding column. 

c) When all the information for a site has been entered, click Save to save it. 

5. For a revisal office: 

a) On the General tab, select the Used for Revisal Office box. 

b) At the bottom of the page, select the Override Fee for Revisal Office box. 

c) Enter the new amount in the Amount column and the COA number in the 
corresponding column. 

d) When all the information for a site has been entered, click Save to save it. 

Before it allows you to save the information, the application will ask you to enter the 
number of days that this site will be used as a revisal office. Enter this in the No. of 
Days field. 



  Part 2 – Office Procedures 

EC 10495 (05/09)  29 

Verify and Print a Lease Agreement 

 

ROPS/SITES details related to polling sites must be verified before Voter 
Information Cards are produced on Day 30. 

To verify and print a lease: 

1. Access the Landlord module in ROPS/SITES. 

2. On the Selection tab, select the landlord for whom to view the lease information. 

3. On the Profile tab, click View Lease. 

a) Select the polling sites you want to include in the lease. 

b) Add the revision dates, if applicable. 

c) Click OK. The lease is displayed.  

4. Verify the information and correct as necessary. 

5. Print the lease and have the RO sign it. 

6. If there are special agreements between the RO and the landlord (security, 
collocation, etc.), a copy of the document must be attached in order to remind 
both parties of their obligations. 

7. Send the signed lease to the landlord for his signature. If the landlord would like 
to be paid by direct deposit, he must attach a void cheque to the lease before 
returning it to you.  

8. Repeat these steps until all leases have been verified, printed and signed.  

 

After the event, all original leases must be returned by Priority Courier and 
under separate cover to Electoral Financing. 
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Procedure 2 – Recruitment of Personnel and 
Registration in ROPS/SITES 

P2.1 Information Gathering 

In the course of his duties, the recruitment officer will be able to supply you with the 
following information concerning the persons that are selected: 

 name; 

 address; 

 SIN (not compulsory at this stage);  

 position; 

 polling site or revisal office where the worker is assigned; 

 the training session, if applicable. 

This information must be entered in ROPS/SITES as it arrives to ensure that 
progress reports are up-to-date and that customized oath forms can be printed for 
these individuals.  

 

The recruitment officer should remind everyone he hires that they should 
bring a void cheque to the training session or on their first day of work in 
order to set up direct deposit of their pay. 

P2.2 Progress Reports on Recruitment  

Three reports are designed to provide information on your progress regarding the 
recruitment of polling day workers: 

 Polling Site Staff; 

 Worker Position Assignment for DRO and Poll Clerks; and  

 DRO and Poll Clerks not assigned to Polling Stations. 

To view these reports: 

1. On the Reports menu, point to Personnel Management, and then click the 
appropriate report. 

2. When the report is displayed on the screen, click the column header to sort in 
ascending or descending order.  

 

For these reports to be useful, ROPS/SITES must constantly be updated 
with the most recent information. 
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P2.3 Registration in ROPS/SITES 

The information gathered at the recruitment stage must be captured in ROPS/SITES 
for each worker. 

Registration of Office Workers Except Revising Agents  

The R2 – Table of Election Workers identifies the positions that fall into this category. 
Registration takes place as soon as you receive the information concerning the 
worker’s recruitment.  

Registration 

1. Access the Worker module in ROPS/SITES. 

2. On the Selection tab, verify that the worker is already listed in ROPS/SITES: 

 If listed, validate the worker’s personal information on the Profile tab, then 
select the Office Staff option in the Allowable Assignment section. 

 If not listed, add the worker on the Profile tab by specifying his name, SIN 
(not mandatory at this stage but preferable), address and phone number, 
then select the Office Staff option in the Allowable Assignment section.  

3. On the Position tab, assign the worker to a position. 

On the First Day of Work 

1. Print the oath, which will have to be verified, corrected and signed by the worker 
then signed by the RO. 

2. If the worker is entitled to additional tax credits, ensure that he has filled out the 
prescribed provincial or federal form. Attach this form to the oath. 

3. If the worker is exempt from paying CPP, ensure that he has submitted the 
necessary proof showing the exemption. Attach this proof to the oath. 

4. Collect the void cheque from any worker who wishes to be paid by direct deposit 
and attach it to the oath. 

5. Provide the worker with his copy of the signed oath, many copies of the Time 
Sheet for the Election Worker (EC 11655) and one copy of the Your Pay 
pamphlet (EC 11800). 

6. If the worker’s position requires travel, provide him with many copies of the 
Kilometre Log (EC 11700). 

7. Using the signed oaths and attachments, enter the corrected or additional 
information for each worker in ROPS/SITES. 

8. File all documents in the personnel records. 
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Registration of Revising Agents 

Registration takes place as soon as you receive the information concerning the 
worker’s recruitment. 

1. Access the Worker module in ROPS/SITES. 

2. On the Selection tab, verify that the worker is already listed in ROPS/SITES: 

 If listed, validate the worker’s personal information on the Profile tab, then 
select the Office Staff option in the Allowable Assignment section. 

 If not listed, add the worker on the Profile tab by specifying his name, SIN 
(not mandatory at this stage but preferable), address and phone number, 
then select the Office Staff option in the Allowable Assignment section. 

3. On the Position tab, assign the worker to a position and to a training session. 
Before payment of training allowances can be made, a one or two-character 
identification code (letter or number) as well as the date of the training session 
must be specified.   

Before they begin work, revising agents must attend a training session. For the steps 
to follow, please refer to Procedure 3 – Staff Training. 

Registration of Poll Officials  

The R2 – Table of Election Workers identifies the positions that fall into this category. 
Registration takes place as soon as you receive the information concerning the 
worker’s recruitment. 

1. Access the Worker module in ROPS/SITES. 

2. On the Selection tab, verify that the worker is already listed in ROPS/SITES: 

 If listed, validate the worker’s personal information on the Profile tab, then 
select the Polling Day Staff option in the Allowable Assignment section. 

 If not listed, add the worker on the Profile tab by specifying his name, SIN 
(not mandatory at this stage but preferable), address and phone number, 
then select the Polling Day Staff option in the Allowable Assignment 
section. 

3. On the Position tab, assign the worker to a position and to a training 
session..Before payment of training allowances can be made, a one or two-
character identification code (letter or number) as well as the date of the training 
session must be specified.  

Before they begin work, poll officials must attend a training session. For the steps to 
follow, please refer to Procedure 3 – Staff Training. 
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Assignment of Multiple Training Sessions to a Worker  

The central poll supervisors and polling day staff on standby will most likely have to 
attend more than one training session. In order to assign more than one training 
session to one worker: 

1. Assign each of these workers to the positions for which they will be trained 
without assigning a polling site or station. 

2. Enter the identification code as well as the date of each training session. Since 
the DRO and poll clerk training is the same, only one training fee (poll clerk) can 
be claimed. 

Before they begin work, these workers will attend a training session. For the steps to 
follow, please refer to Procedure 3 – Staff Training. 

P2.4 Deletion of Worker Information 

The information recorded on a tab is linked to the information recorded on the tabs to 
its right. Therefore, to delete the content of a tab, you must first delete the 
appropriate information on the tabs starting with the Comment tab and proceed to 
the left with the Timesheet, Other Payments and Positions tabs. 

 

The error message “Cannot delete this record. Other table(s) have reference 
to it.” indicates that there is still some relevant information for this record on 
the tabs to its right. 

To delete a timesheet and other payments 

The timesheet to be deleted must be highlighted in white. If it is not, the record was 
already confirmed at the end of the last pay period and it cannot be deleted. 

To delete a position assigned to a worker 

You must first delete the timesheets and other payments relevant to the position. No 
need to delete the information pertaining to the worker’s other positions. If a payment 
or timesheet for the targeted position was confirmed at the end of the last pay period, 
you will not be able to delete the position. 

To delete a worker’s profile 

You must delete all information on the tabs to the right of the Profile tab. If a 
payment was already confirmed at the end of the last pay period, you will not be able 
to delete the worker’s profile. 
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Procedure 3 – Staff Training 

P3.1 Preparation of Data Before Training 

At the recruitment stage, people were assigned to one or several training sessions. 
For the list of workers entitled to receive the training allowance, please refer to the 
R2 – Table of Election Workers at the end of this manual. For the steps involved in 
assigning one or several training sessions to a worker, please refer to Procedure 2 – 
Recruitment of Personnel and Registration in ROPS/SITES. 

The Workers Not Yet Scheduled for Training Report 

This report lists the name and position of any worker who has not yet been assigned 
to training. It is designed to allow you to complete data entry before training begins.  

To access this report: 

1. On the Reports menu, point to Personnel Management, and then click 
Workers Not Yet Scheduled for Training.  

2. When the report is displayed on the screen, click the column header to sort in 
ascending or descending order.  

P3.2 Before the Training Session 

1. Ensure that all data entry related to recruitment is complete  

2. For each worker eligible for the training allowance, enter a one or two-character 
identification code (letter or number), as well as the date of the training session 
on the Position tab. 

3. To print a customized oath form for each participant: 

a) On the Reports menu, point to Personnel Management, and then click 
Oath by Training Session. 

b) Click Print. 
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P3.3 During the Training Session  

1. Ask each worker to verify, correct, sign and date the oath, prior to having it 
signed by the RO. 

2. If the worker is a poll official, go to step 3. If the worker is a revising agent, 
ensure that:  

 Any worker who is entitled to additional tax credits has filled out the 
prescribed provincial or federal form. Attach this form to the oath. 

 Any worker who is exempt from paying CPP has submitted the necessary 
proof showing the exemption. Attach this proof to the oath. 

3. Participants who used their own vehicle to attend training and who travelled more 
than 35 km round trip can fill out a Kilometre Log (EC 11700) (one form per 
person) with the total number of kilometres travelled. Attach this form the 
participant’s oath. 

4. Collect the void cheque from any worker who wishes to be paid by direct deposit 
and attach it to the oath. 

5. Provide the worker with his copy of the signed oath and one copy of the Your 
Pay pamphlet (EC 11800). 

6. If the worker is a revising agent, provide him with many copies of the Time Sheet 
for the Election Worker (EC 11655) and of the Kilometre Log.  

7. For the participants whose services will not be retained, cross out and indicate on 
the oath: NOT RETAINED. Keep the oath with the others. The RO will decide if 
training will be paid to these participants.  

P3.4 After Each Training Session  

1. Ensure that all oath forms have been signed and that the RO or other delegated 
officer has authorized all Kilometre Logs (EC 11700). 

2. Update worker profiles and assignments in ROPS/SITES, based on any modified 
oath forms and attached documentation (SIN, banking info, new address, etc.). 

3. Access the Training module in ROPS/SITES. Select the Attended Training box 
for each attendee. 

To confirm attendance of all participants to a training session in one step: 

a) Access the Training module. 

b) Click Select All. 

c) Specify the training session. 

d) Click OK. 

If the Attended Training box is not selected, the worker will receive neither the 
training nor the associated travel allowance. 
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Updating the Profile of Retained Workers 

1. Access the Training module in ROPS/SITES. Ensure that the Attended 
Training box is selected for each attendee. 

2. Access the Worker module. 

3. On the Selection tab, select the worker. 

4. On the Profile tab, update worker profiles and assignments based on any 
modified oath forms and attached documentation (SIN, banking info, new 
address, etc.).  

5. On the Position tab, review the position and poll assignment, and modify if 
necessary.  

6. On the Other Payments tab, add the total number of kilometres traveled based 
on the Kilometre Log signed by the RO. 

Updating the Profile of Workers Who Were Not Retained if the Training Fee Is 
To Be Paid 

1. Access the Training module in ROPS/SITES. Ensure that the Attended 
Training box is selected for each attendee.  

2. Access the Worker module. 

3. On the Selection tab, select the worker. 

4. On the Position tab, delete the polling site or polling station assignment. Do not 
delete the position, as it would prevent the payment of the training fee.  

5. On the Comment tab, add Services not retained.  

6. On the Other Payments tab, add the total number of kilometres traveled based 
on the Kilometre Log signed by the RO.  

Updating the Profile of Workers Who Were Not Retained if the Training Fee Is 
Not To Be Paid 

1. Access the Training module in ROPS/SITES. Ensure that the Attended 
Training box is not selected for this attendee.  

2. Access the Worker module. 

3. On the Selection tab, select the worker. 

4. On the Position tab, remove all assignments to polling site, polling station and 
position.  

5. On the Comment tab, add Services not retained. 
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P3.5 Progress Report on Training  

This report can be produced at any time. For each individual, it specifies the date 
and identification number of the training session, the attendance and when the 
payment request was sent.  

To view this report: 

1. Access the Training module in ROPS/SITES. 

2. Click Print. 

3. When the report is displayed on the screen, click the column header to sort in 
ascending or descending order.  
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Procedure 4 – Management of Budgeted Hours in 
ROPS/SITES 

P4.1 Positions: Budget vs. Actual Worked report 

At the end of each week or as often as the RO wants, provide him with the Positions: 
Budget vs. Actual Worked report. This report is produced in ROPS/SITES and 
accounts for all office staff time sheets entered in the system. It is therefore important 
to enter all submitted time sheets before producing this report.  

To view this report: 

1. On the Reports menu, point to Time Management, and then click Positions: 
Budget vs. Actual Worked. 

2. When the report is displayed on the screen, click the column header to sort in 
ascending or descending order.  

P4.2 Transfer of Hours Between Positions 

You can transfer hours between positions shown in italics in the official budget. It is 
important to evaluate the needs for each position so that when you transfer hours, 
you do not create a subsequent deficit in the position that provides the hours.  

1. On the Edit menu, point to General Information, and then click Budget 
Information. 

2. To process a transaction: 

a) On the Budget Hours tab, select the position providing the hours in the 
Transfer from column.  

b) In the Transfer to column, select the position receiving the hours. If the field 
is shaded, the transfer is not possible. 

c) In the No. Transfer Hours column, specify the number of hours to be taken 
from the providing position.  

d) Click Calculate. The system accounts for the different hourly rates and 
calculates the corresponding number of hours to be received.  

If you have another transaction to process, repeat step 2. If not, proceed to the 
step 3. 

3. Click Save to register the transactions and update the page.  
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4. To print each transaction: 

a) On the Budget Activity tab, select the transaction to be printed by aligning 

the hand indicator  with the desired record. 

b) Click Print. The report is displayed on the screen. 

c) Click Print again to produce the paper version of the report.  

 
The Budget Hours report is automatically printed as well. 

5. Disregard the “Please fax this report…” instruction at the top of the report.  

6. Submit the transactions to the RO for signature, then file them with the personnel 
management records. 

P4.3 Requests for Additional Hours 

The RO can submit a request for additional hours to EC when it is no longer possible 
to transfer hours from one position to another.  

1. Open the electronic template RO Special Request (EC 10326) and fill out all 
appropriate fields. Ensure that the justification contains sufficient details.  

2. Print the Budget Activity report in ROPS/SITES: 

a) On the Reports menu, point to Time Management, and then click Budget 
Activity.  

b) Click Print. 

3. Print the Budgeted Hours report in ROPS/SITES: 

a) On the Reports menu, click Time Management, and then click Budgeted 
Hours.  

b) Click Print. 

4. Submit the RO Special Request and both ROPS/SITES reports to the RO for 
approval. 

5. The request and reports must be faxed to Electoral Coordination for their 
approval.  

 

Exception: Requests for additional hours for the financial officer are to be 
sent to Electoral Financing. 
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P4.4 Approved Additional Hours 

When a request is authorized by Elections Canada, the RO will receive a Control of 
Authorization (COA) number by e-mail. This number must be entered in 
ROPS/SITES, along with the authorized amount.  

1. On the Edit menu, point to General Information, and then click Budget 
Information. 

2. To process an approval: 

a) On the Budget Hours tab, select the position receiving the additional hours 

by aligning the hand indicator  with the desired position.  

b) In the Additional Approval column, enter the number of hours authorized. 

c) In the COA Approval Number column, enter the COA number.  

If you have received another approval, repeat step 2. If not, proceed to step 3. 

3. Click Save to register the transactions and update the page. 

4. To print each transaction: 

a) On the Budget Activity tab, select the transaction to be printed by aligning 

the hand indicator  with the desired record. 

b) Click Print. The report is displayed on the screen. 

c) Click Print again to produce the paper version of the report.  

 
The Budget Hours report is automatically printed as well. 

5. Add the transaction report and the approval e-mail to the request already filed in 
the financial management files. 

P4.5 Summary of Budget Activities 

This report can be produced at any time in order to review transfer activities and 
budget increases for all office positions.  

To produce this report: 

1. On the Reports menu, point to Time Management, and then click Budget 
Activity.  

2. Click Print. 
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Procedure 5 – Confirmation of Polling Day Activities 

These procedures are designed to help report the polling day workers’ activities 
(advance and ordinary polls) and to update ROPS/SITES.  

P5.1 Before Polling Day 

The Polling Site Report 

For each polling site, the Polling Site Report (PSR) indicates the name, position and 
phone number of each assigned worker along with the landlord contact details. 
These reports are very useful when monitoring polling day activities. To produce a 
PSR: 

1. To ensure the accuracy of the PSR, you must complete data entry concerning 
landlords and polling day workers. 

2. To print one PSR: 

a) Access the Landlord module in ROPS/SITES. 

b) Click Search for site. 

c) Select the desired site. 

d) Select a facility. 

e) Click View Site Report. 

f) Click Print. 

 

To print all PSRs at once, access the Landlord module and click Print 
all report(s). 

3. Distribute to each central poll supervisor or person in charge: 

 their own PSR at least one day before the poll; 

 a sufficient number of copies of the Time Sheet for the Election Worker 
(EC 11655) to account for the positions with hourly rates of pay and for the 
return of ballot boxes;  

 a sufficient number of copies of the Kilometre Log (EC 11700), to account for 
the return of ballot boxes.  

4. The PSR can be used for the wake-up calls on the eve or the morning of polling 
day.  
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P5.2 Confirmation of Polling Day Activities 

The central poll supervisor or person in charge: 

1. Uses the Polling Site Report (PSR) to confirm who did what by: 

 verifying the names of those who attended; 

 striking the names of absentees; 

 correcting the position assignments; 

 adding the name and position of replacement personnel if need be; and 

 indicating the number of hours worked for workers paid on a hourly basis.  

2. Provides a Time Sheet for the Election Worker (EC 11655) and Kilometre Log 
(EC 11700) (used to record the time and distance traveled) to any worker who is 
asked to return the ballot box. 

3. After the poll, signs the PSR and sends it to the RO office.  

P5.3 Administrative Procedures for the Return of Ballot Boxes 

1. The number of travel hours is recorded on the Time Sheet for the Election 
Worker (EC 11655) (one per individual). 

2. The number of kilometres is recorded on the Kilometre Log (EC 11700) (one per 
individual). 

3. These forms must be signed by the RO or other delegated officer and filed with 
the returned polling site reports. 
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Procedure 6 – Finalizing Payments in ROPS/SITES 

P6.1 Entering the Information for Office Workers 

Entry of Time Sheets in ROPS/SITES 

To enter time sheets in ROPS/SITES: 

1. Access the Worker module. 

2. On the Selection tab, select the worker.  

3. On the Timesheet tab, enter the number of hours for each day, for each 
corresponding position.  

Bear in mind that a worker can fill several positions.  

Entry of Travel Kilometres in ROPS/SITES 

To enter travel kilometres in ROPS/SITES: 

1. Access the Worker module. 

2. On the Selection tab, select the worker. 

3. On the Other Payments tab, click Add. 

4. Select the position and the appropriate rate. 

5. Complete the information fields by specifying the date that the travel occurred. 

P6.2 Entering the Information for Poll Officials 

Update of ROPS/SITES 

Use the signed polling site reports (PSR), time sheets and kilometre logs to verify 
and correct the data entry in ROPS/SITES.  

 

Enter all fees and expenses related to advance polls before Day 0 to avoid 
confusion and lighten your workload after ordinary polling day. This could 
speed up payment confirmation for polling day workers and landlords. 

Entry of Time Sheets in ROPS/SITES 

To enter time sheets in ROPS/SITES: 

1. Access the Worker module in ROPS/SITES. 

2. On the Selection tab, select the worker.  

3. On the Timesheet tab, enter the number of hours for each day, for each 
corresponding position.  

Bear in mind that a worker can fill several positions.  
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When an Assigned Worker Does Not Report for Work on Polling Day 

Some time sheets are produced automatically and must be deleted to avoid paying a 
person who did not report for work. 

1. Access the Worker module in ROPS/SITES. 

2. On the Selection tab, select the worker. 

3. On the Timesheet tab, delete the time sheet if necessary. 

4. On the Position tab, delete the polling site or station assignment. 

5. On the Comment tab, add Withdrawal. 

6. The RO will decide if training is paid to workers who did not show up for work. If 
the RO decides that the training fee is not to be paid: 

a) On the Other Payments tab, delete the training kilometres if applicable. 

b) Access the Training module, and then clear the Attended Training box.  

When a Person on Standby Works on Polling Day 

An individual cannot be simultaneously on standby and assigned to a position. 
During advance polls, it is possible that a worker will have been on standby for a day 
or two, then called in to work. In such cases, you can count two hours per day on 
standby. 

If a worker on standby is called to work, the following information must be modified: 

1. Access the Worker module in ROPS/SITES. 

2. On the Selection tab, select the worker. 

3. On the Position tab, add the position and appropriate assignment to the 
substitute. 

4. On the Timesheet tab, delete or modify the standby time sheet and add the time 
sheet for the position occupied if it was not produced automatically.  

When a Worker Works Only Part of the Day 

Hourly Rate Positions – Central Poll Supervisor, Registration Officer and Information 
Officer 

For these positions, please modify the time sheet by sharing the number of hours 
between the workers who shared the work. The total number of shared hours cannot 
exceed the authorized maximum for the position. 

Fixed Fee Positions – DRO and Poll Clerk 

Since it is not possible to enter dollar amounts in ROPS/SITES, time sheets for the 
fixed fee position indicate a default 28 hours for advance poll and a default 14 hours 
for ordinary poll positions. These numbers cannot be exceeded and guarantee that 
the worker will be paid the full fee as specified in the Federal Elections Fees Tariff. 
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If a worker leaves before the end of the day and a substitute is called to finish the 
work, the time sheets must be modified to reflect the division of hours between the 
workers. Usually each share is determined by the ratio of work accomplished. The 
RO has to decide how many hours will be attributed to each worker. 

Entry of Travel Kilometres or of Hours for the Return of Ballot Boxes in 
ROPS/SITES 

To enter travel kilometres or hours for the return of ballot boxes in ROPS/SITES: 

1. Access the Worker module in ROPS/SITES. 

2. On the Selection tab, select the worker. 

3. On the Other Payments tab, click Add. 

4. Select the position and the appropriate rate. 

5. Complete the information fields by specifying the date that the travel and 
additional hours occurred. 

P6.3 Confirmation of the Payment File for Workers in ROPS/SITES 

This confirmation occurs four times during a regular election calendar; the first, 
second and third pay periods (PP1, PP2 and PP3) and the polling day pay (PPV).  

Once the payment file has been confirmed by the RO in ROPS/SITES, it can no 
longer be modified. It is therefore crucial that verification of data entry be performed 
before this confirmation occurs. If in spite of your efforts some information was still 
omitted, enter it in the system for it to be processed when the next pay period occurs.  

The first and second pay period: PP1 and PP2 

The payment authorization file for these pay period will indicate the hours, km and 
training fees for the officer workers only. Those file are not cumulative and therefore 
show only the information that has not been confirmed yet. 

Some office workers are also acting as poll officials. In these cases the payment 
information concerning the polling day positions (training fee included) will only be 
processed in the third pay period (PP3). 

The third pay period: PP3 

The payment authorization file will indicate the hours, km and training fees that have 
not yet been confirmed for office workers and those who also acted as poll officials. 

 

The data entry for polling day worker expenses and fees must be 
completed in ROPS/SITES before processing the 3rd pay confirmation. 
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Confirmation of PP1, PP2 and PP3 in ROPS/SITES 

The same process applies for each of the three confirmations: 

1. Are the hours for fixed salary positions (AC, AAC and AARO) entered? Please 
refer to the Aide-Mémoire of Financial Activities (EC 11657) for the exact number 
of hours to enter. 

2. Are the assigned positions and time sheets entered correctly?  

For each worker, the Timesheet Reconciliation Report allows you to reconcile 
time sheets with the hours entered that are not yet confirmed in the system. 

Please note that even if the Timesheet Reconciliation Report might include 
information about poll officials, only the office position information will appear on 
the payment authorization reports for PP1 and PP2.   

 

This report does not allow you to reconcile other expenses, such as travel 
kilometres and training fees. 

To produce this report in ROPS/SITES: 

a) On the Reports menu, point to Personnel Management, and then click 
Timesheet Reconciliation. 

b) Click Payroll Workers. 

3. If the worker is a revising agent, did he attend training? If so, access the 
Training module and ensure that the Attended Training box has been selected. 

4. Have the kilometres travelled for training or service been entered? Access the 
Worker module and see the Other Payment tab.  

5. To verify payment information in ROPS/SITES, print the Payment Authorization 
Report (PAR) as follows: 

a) On the File menu, click Confirm Payroll Worker Payments. 

b) To activate the Print button, select the lines that you wish to print. 

c) Click Print.  

6. If necessary, modify the payment information in ROPS/SITES and reproduce the 
PAR until it is accurate. 

7. To confirm payments in ROPS/SITES: 

a) On the File menu, click Confirm Payroll Worker Payments. 

b) Click Select All. 

c) Click Print.  

d) Click Confirm. 

e) Ask the RO to confirm the data in ROPS/SITES with his password. The final 
summary PAR will print automatically.  
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8. Have the RO sign the final PAR–Summary and fax it to Electoral Financing.  

9. Keep the final detail and summary PAR in the financial management file.  

The Polling Day Worker Pay Period 

Information relating to the payment of poll officials is submitted to Elections Canada 
only once, via ROPS/SITES, no later than four days after polling day.  

The payment authorization file will indicate hours, kilometres travelled and training 
fees for poll officials who worked at advance polls and on ordinary polling day. 

 

Payment information concerning workers who occupied an office position 
and a polling day position will appear only on the Payment Authorization 
Report for the 3rd pay period. 

Confirmation of Polling Day Worker Pay Period in ROPS/SITES  

Here are the steps to follow: 

1. Has the information corrected on the Polling Site Report been entered in 
ROPS/SITES? Are the assigned positions and time sheets correct?  

For each worker, the Timesheet Reconciliation Report allows you to reconcile 
time sheets with the hours entered that are not yet confirmed in the system. The 
information for the poll officials who also occupied an office position will appear 
only on the Payment Authorization Report for PP3. 

 

This report does not allow you to reconcile other expenses, such as travel 
kilometres. 

To produce this report in ROPS/SITES: 

a) On the Reports menu, point to Personnel Management, and then click 
Timesheet Reconciliation. 

b) Click Polling Day Workers. 

2. Did the worker attend training? If so, access the Training module and ensure 
that the Attended Training box has been selected. 

3. Have the kilometres travelled for training or service been entered? Access the 
Worker module and see the Other Payment tab.  

4. To verify payment information in ROPS/SITES, print the Payment Authorization 
Report (PAR) as follows: 

a) On the File menu, click Confirm Polling Day Worker Payments. 

b) To activate the Print button, select the lines that you wish to print. 

c) Click Print. 

5. If necessary, modify the payment information in ROPS/SITES and reproduce the 
PAR until it is accurate. 
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6. To confirm payments in ROPS/SITES: 

a) On the File menu, click Confirm Polling Day Worker Payments. 

b) Click Select All. 

c) Click Print. 

d) Click Confirm. 

e) Ask the RO to confirm the data in ROPS/SITES with his password. The final 
summary PAR will print automatically.  

7. Have the RO sign the final PAR–Summary and fax it to Electoral Financing.  

8. Send the final detail PAR and the signed Polling Site Reports by Priority Courier 
to Electoral Financing.   

P6.4 Confirmation of the Payment File for Rental of Polling Sites 

Information relating to the payment of polling sites is submitted to Elections Canada 
only once, via ROPS/SITES, no later than four days after polling day.  

1. Is the information in ROPS/SITES complete? 

2. To verify payment information in ROPS/SITES, print the Payment Authorization 
Report (PAR) as follows: 

a) On the File menu, click Confirm Landlord Payments. 

b) To activate the Print button, select the lines that you wish to print. 

c) Click Print. 

3. If necessary, modify the payment information in ROPS/SITES and reproduce the 
PAR until it is accurate. 

4. To confirm payments in ROPS/SITES: 

a) On the File menu, click Confirm Landlord Payments. 

b) Click Select All. 

c) Click Print. 

d) Click Confirm. 

e) Ask the RO to confirm the data in ROPS/SITES with his password. The final 
PAR will print automatically.  

5. Have the RO sign the final PAR–Summary and fax it to Electoral Financing.  

6. Keep the final detail and summary PAR in the personnel management file.  

7. After the event and before the RO’s office closes, return all original signed leases 
under separate cover by Priority Courier to Electoral Financing.  
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Procedure 7 – Administration of Purchases 

P7.1 Administering the Acquisition Card 

Purchases Made with the Acquisition Card 

 Check the cash register slip and the receipt to ensure the accuracy of the 
charges. 

 Check that the supplier did not charge PST. 

 File the cash register slip and receipt so that you can use it later on during 
reconciliation. 

Problems with the Monthly Statement 

 Highlight the problematic operations in both documents. 

 The RO calls the credit card company to resolve the discrepancy. 

 The RO contacts Electoral Financing if necessary to help resolve the 
discrepancy. 

Reconciliation to be Sent to Elections Canada 

The reconciliation of purchases made with the card must be sent to Electoral 
Financing within five days of receiving the monthly statement. 

As soon as the statement arrives, you must: 

1. Check every operation listed on the statement, and compare it to your receipts.  

2. Enter the transactions in the Acquisition Card Register (EC 11715) that you can 
get from ROPS/SITES or ECDocs. 

3. Print the Acquisition Card Register. 

4. Once the reconciliation has been made, ask the RO to sign both the register and 
the statement. Do not wait for discrepancies to be resolved.  

5. Make a copy of the register, receipts and invoices and of the monthly statement 
for the RO’s files. 

6. Send by Priority Courier to Electoral Financing: 

 the signed register; 

 the original invoices, receipts or other proof of expense; 

 the monthly statement from the credit card company signed by the RO; 

 explanations of any problem transactions, if need be. 
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Lost or Stolen Card 

If a card is lost or stolen: 

 The RO calls the credit card company. 

 The RO informs Electoral Financing. 

P7.2 Administering the Accountable Advance for Petty Cash 

RO Receives Cheque for Petty Cash 

 The RO cashes the cheque and keeps the funds in a secure location. 

 The RO puts $250 in a locked box, which is kept in a locked drawer. Contents 
will be replenished as necessary. 

Purchases from Petty Cash 

 For each expense paid out of petty cash (maximum $200 per transaction), an 
original proof of expense must be obtained (cash register receipt, invoice, etc.).  

 Register each expense in the Record of Reimbursable Expenses from Petty 
Cash (EC 11710) in ROPS/SITES.  

Reconciliation of Petty Cash Advance 

The reconciliation must be sent to Electoral Financing no later than Day –10.  

1. Print the Record of Reimbursable Expenses from Petty Cash, then attach 
receipts and proof of payment. Do not forget any justifications for the use of 
temporary help advance. 

2. Have the form verified and signed by the RO. 

3. Subtract the difference between the two advances received and the total in the 
Record of Reimbursable Expenses from Petty Cash. 

4. The RO writes a cheque to the order of the Receiver General for Canada for the 
amount of any unused funds. 

5. Keep a copy of the forms and attachments in the RO’s files. 

6. Send by Priority Courier to Electoral Financing: 

 the signed register; 

 the original invoices, receipts or other proof of expense; 

 a cheque made to the Receiver General to reimburse the unused amount. 
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P7.3 Administering the Accountable Advance for Temporary Help 

RO Receives Cheque for Temporary Help 

The RO cashes the cheque.   

RO Needs Temporary Help  

This advance must never be used to hire individuals to affix labels. It is used only to 
hire groups.  

If the RO decides to hire a group, each worker in that group must sign the oath form, 
which must then be signed by the RO. 

If the RO decides to hire individuals to affix labels, you must register each worker 
in ROPS/SITES as an office clerk. 

The Group Finishes the Work and Must be Paid 

The financial officer provides the invoice to the RO, who will authorize payment. The 
RO then pays the group and obtains a receipt. 

Reconciliation of Advance for Temporary Help 

The reconciliation must be sent to Electoral Financing no later than Day –10. 
Information concerning the use of this advance must be added to the reconciliation of 
petty cash as itemized in the Record of Reimbursable Expenses from Petty Cash 
(EC 11710). 

The procedures described above for the reconciliation of the petty cash advance 
apply to the advance for temporary help. 

P7.4 Submission of the Special Account Form (EC 11670) to 
Elections Canada 

The Special Account Form (EC 11670) is used when it is not possible to use the 
acquisition card, an accountable advance or ROPS/SITES to buy or rent goods and 
services. 

1. Fill out all sections of the form.  

a) If the supplier is a company, include their name, address, GST number or 
business number. 

b) If the supplier is an individual, include his name, address and SIN. 

c) Describe the goods or services with as much detail as possible. 

2. Attach original invoices or proof of purchase. 

3. Have the form verified and signed by the RO. 

4. Keep a copy of the form and attachments in the RO’s files. 
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5. Send immediately by Priority Courier to Electoral Financing: 

 the original, signed Special Account Form; 

 original invoices and proof of purchase. 
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Procedure 8 – ROPS/SITES Decommissioning 

Decommissioning is a very important process because it indicates to Elections 
Canada that all transactions are complete and that the computers can be returned to 
Elections Canada. ROPS/SITES should be decommissioned as soon as possible. 

 

The decommissioning process can be initiated as soon as all records have 
been confirmed. If some records remain unconfirmed, ROPS/SITES will give 
a warning message. 

P8.1 In Order to Decommission ROPS/SITES  

To decommission ROPS/SITES:  

1. On the File menu, click Save ROPS/SITES data to Excel.  

This process saves all worker and landlord information to your server. The 
decommissioning process cannot continue unless this is done. A report will be 
printed to indicate that the ROPS/SITES data was saved to Excel spreadsheets. 

2. Then, on the File menu, click ROPS System Deactivation.  

A message will then appear saying that the deactivation was successful and a 
report will be printed to indicate that ROPS/SITES was deactivated. 

 

The data will be transferred to a CD by the automation coordinator before the 
computers are purged. This information will be very valuable when preparing 
for the next electoral event. 

 





    

 

Part 3 – References 

This part of the Financial Officer’s Manual contains the following: 

 R1 – Acronyms 

 R2 – Table of Election Workers 

 R3 – Table of Expenditures 

 R4 – Expenses Paid Directly by Elections Canada 

 R5 – Finance Forms 

 R6 – Statutory Reports 

 





  Part 3 – References 

EC 10495 (05/09)  59 

R1 – Acronyms 

AAC Assistant automation coordinator 

AARO Additional assistant returning officer 

AC Automation coordinator 

ARO Assistant returning officer 

COA # Control of Authorization Number  

CPP Canada Pension Plan 

CPS Central poll supervisor 

CRO Community relations officer 

DRO Deputy returning officer 

EC Elections Canada 

ECDocs Suite of operational manuals for federal electoral events 

ECSN Elections Canada Support Network 

ED Electoral district 

EI Employment Insurance 

FLO Field liaison officer 

GST Goods and Services Tax 

HST Harmonized Sales Tax 

PAR Payment Authorization Report (produced in ROPS/SITES) 

PP Pay period 

PSR Polling Site Report 

PST Provincial Sales Tax 

QPIP Québec Parental Insurance Plan 

QPP Québec Pension Plan 

REVISE Automated system used to update elector information during an electoral event 

RO Returning officer 

ROE Record of Employment 

ROPS Returning Office Payment System 

SBC Special ballot coordinator 

SIN Social Insurance Number 

SVR Special Voting Rules 

VIC Voter Information Card 
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R2 – Table of Election Workers  

Position 
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Office Staff        

Additional Assistant Returning Officer Yes No Yes 
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EC 10135 No Yes 

Assistant Automation Coordinator Yes No Yes EC 10135 No No 

Assistant Returning Officer No No Yes N/A No Yes 

Automation Coordinator Yes No Yes EC 10135 No Yes** 

Community Relations Officer Yes Yes Yes EC 10135 No Yes 

Financial Officer Yes Yes Yes EC 10135 No No 

Inventory/Shipping Clerk Yes Yes Yes EC 10135 No No 

Office Clerk Yes Yes Yes EC 10135 No No 

Office Coordinator Yes Yes Yes EC 10135 No No 

Office Messenger Yes Yes Yes EC 10135 No Yes 

Receptionist Yes Yes Yes EC 10135 No No 

Recruitment Officer Yes Yes Yes EC 10135 No Yes 

Returning Officer No No Yes N/A No Yes 

Revising Agent Yes Yes Yes EC 10130 Yes Yes 

Revision Centre Clerk Yes Yes Yes EC 10135 No No 

Revision Supervisor Yes Yes Yes EC 10135 No No 

Special Ballot Coordinator Yes Yes Yes EC 10135 No Yes 

Security Officer No Yes  Yes EC 10135 No No 

Support Staff for AARO Office Yes Yes Yes EC 10135 No No 

Training Officer Yes Yes Yes EC 10135 No Yes 

**: If approved by the Chief Electoral Officer
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Poll Officials        

Central Poll Supervisor Yes Yes No* 
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EC 10130 Yes Yes 

Deputy Returning Officer – Correctional 
Institutions 

Yes Yes No* EC 10130 Yes No 

Deputy Returning Officer – Ordinary, Advance 
or Mobile Polls, or Counting special ballots 

Yes No No* EC 10130 Yes No 

Deputy Returning Officer – Returning ballot 
boxes 

Yes Yes No* EC 10130 No Yes 

Deputy Returning Officer – Standby Yes No No* EC 10130 Yes No 

Hospital Liaison Officer Yes No No* EC 10130 No Yes 

Information Officer Yes Yes No* EC 10130 Yes No 

Interpreter – Language Yes Yes No* EC 10130 No Yes 

Interpreter – Sign-Language No Yes No* EC 10130 No Yes 

Person responsible for maintaining order No Yes No* EC 10130 No No 

Poll Clerk – Correctional Institutions Yes Yes No* EC 10130 Yes No 

Poll Clerk – Ordinary, Advance or Mobile 
Polls, or Counting special ballots 

Yes No No* EC 10130 Yes No 

Poll Clerk – Returning ballot boxes Yes Yes No* EC 10130 No Yes 

Registration Officer Yes Yes No* EC 10130 Yes No 

Special Ballot Coordinator Hospital Yes Yes No* EC 10135 No Yes 

Special Messenger for delivery or pickup of 
ballot boxes 

Yes Yes No* EC 10130 No Yes 

Witness at validation of results Yes Yes No EC 10130 No No 

*:  Source deductions may be withheld if a worker is assigned to more than one position. 
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R3 – Table of Expenditures 

Payment Method  

 

Expenditure Type  R
O
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T
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Rentals       

Rental of RO/AARO office 
(including security) 

  
   Mandatory 

Send lease to EC 

Rental of furniture and office 
equipment 

 X* 
  

X  

Rental of training space  X*  X< $200 X  

Rental of polling sites/revisal 
offices 

X  
  

 Mandatory 

Purchase of Goods & 
Services 

  
  

  

Office supplies  X*  X< $200 X  

Priority Courier      Managed by EC 

Other shipping and courier 
services 

 X* 
 

X   

Security guard (company)  X*  X< $200 X  

Security guard (individual)     X Mandatory 

Cleaning services (company)  X*  X< $200 X  

Cleaning services (individual)     X Mandatory 

Printing of ballot papers, voter 
information cards and lists of 
electors 

 X* 
  

X  

Telephone, fax lines      Managed by EC 

Groups to paste labels on VICs   X   Mandatory 

Individual to paste labels on 
VICs 

X  
  

 
Mandatory 
(Office Clerk) 

Cellular phones for poll officials 
  

 
X X 

See related instructions 
in this manual 

Note: * Preferred Payment Method 
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R4 – Expenses Paid Directly by Elections Canada  

 Expenses  Procedure  

     

1 

Pre-authorized 
travel expenses not 
registered in 
ROPS/SITES 

- 

Only for travel/ 
kilometre expenses. 

a) 

Worker completes Travel Expense Claim and Time Sheet 
(EC 09680). 

 

b) RO signs the completed form.  

c) Photocopy the signed form and receipts.  

d) 
Submit the original, signed form and receipts to Electoral 
Financing by Priority Courier. 

 

     

2 

Miscellaneous 
expenses 

- 

When the acquisition 
card or petty cash 
cannot be used 

a) 
Complete Special Account Form (EC 11670) (E-form in 
ECDocs). 

 

b) Attach original invoices to the form.  

c) RO signs the form and invoices.  

d) Photocopy the signed form and invoices.  

e) 
Submit the original, signed form and original signed invoices 
to Electoral Financing by Priority Courier. 

 

     

3 

Hours worked in 
positions that are not 
in ROPS/SITES 

- 

Persons responsible 
for maintaining order 
or cleaning staff 

a) 
Complete Special Account Form (EC 11670) with the 
person’s name, address and SIN, the number of hours and 
the agreed rate. 

 

b) RO signs the form (one per person).  

c) 

Make two copies of the signed form: 

 One copy to worker; 

 One copy to personnel file. 

 

d) 
Submit the original, signed form to Electoral Financing by 
Priority Courier. 

 

     

4 
Hours worked after 
ROPS/SITES is 
decommissioned 

a) Same procedure as item 3. 
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R5 – Finance Forms  

EC No. Title Source 

EC 09600 Rates for Travel and Living Expenses ECDocs 

EC 10130 Appointment and Oath (for election or referendum officers) ROPS/SITES 

EC 10135 Appointment and Oath (for office staff) ROPS/SITES 

EC 10326 RO Special Request ECDocs 

EC 10330 Candidate’s Deposit Transmittal ECDocs 

EC 11650 Sales and Consumption Taxes Exemption Certificate ECDocs 

EC 11655 Time Sheet for the Election Worker ECDocs 

EC 11657 Aide-Mémoire of Financial Activities ECDocs 

EC 11670 Special Account Form ECDocs 

EC 11700 Kilometre Log ECDocs 

EC 11710 Record of Reimbursable Expenses from Petty Cash ROPS/SITES 

EC 11715 Acquisition Card Register 
ROPS/SITES 
and ECDocs 

EC 11730 Petty Cash Receipt Paper – Lot 11 

EC 11750 Standard Contract of Lease ROPS/SITES 

EC 11800 Your Pay Paper – Lot 11 
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R6 – Statutory Reports  

 Day 29: prepare for distribution the list of revising agents. In ROPS/SITES, see 
the Revising Agents report. 

 Day 18: prepare the attachment for the Notice of Grant of a Poll (EC 10170). In 
ROPS/SITES, see the List of Polling Sites (Condensed) report. 

 Day 18: prepare the Notice of Advance Poll (EC 10140). In ROPS/SITES, see 
the Notice of Advance Polls report. 

 Day 15: prepare the Notice of Mobile Poll (EC 10160). In ROPS/SITES, see the 
Notice of a Mobile Poll report. 

 Day 3: prepare for posting the List of Officers (EC 10290) for DRO and poll clerks 
who worked during the advance poll or who will work on ordinary polling day. In 
ROPS/SITES, see the DRO/Poll Clerks – Advance Poll and DRO/Poll Clerks – 
Ordinary Poll reports. 
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Index 

3 

35 hr rule for CPP, QPP and EI, 19 

A 

AARO office lease, 27 
accountable advance for petty cash, 8 

administering, 52 
accountable advance for temporary help, 

8 
administering, 53 

acquisition card, 8 
administering, 51 

acronyms, 59 
administration of purchases 

administering accountable advance for 
petty cash, 52 

administering accountable advance for 
temporary help, 53 

administering acquisition card, 51 
submission of Special Account Form to 

AC, 54 
Aide-Mémoire of Financial Activities, 6 
Assignment of Multiple Training Sessions 

to a Worker, 34 
authorized methods of payment, 8 

C 

Canada Pension Plan (CPP), 20 
cell phone expenses, 17 
confirmation of polling day activities 

before polling day, 43 
polling day, 44 
procedures for returning of ballot boxes, 

44 

D 

data preparation before staff training, 35 
direct deposit into chequing account, 11 
direct deposit into non-chequing account, 

12 

E 

election workers, 11 
methods of payment, 11 
other payments entered in 

ROPS/SITES, 15 
other payments not entered in 

ROPS/SITES, 16 
pay periods, 17 
personal information in ROPS/SITES, 

13 
rates of pay, 13 

elections workers, table, 60 
electoral facilities, 9 

AARO office rental, 9 
polling sites, 9 
RO office rental, 9 

Employment Insurance (EI), 20 
expenditures, table, 62 
expenses paid directly by EC, 63 

F 

Federal and Provincial Income Tax, 19 
Federal Elections Fees and Tariff, 6 
Federal Goods and Services Tax (GST), 7 
finalizing payments 

confirmation of payment file for rental of 
polling sites, 50 

confirmation of payment file for 
workers, 47 

entering information for office workers, 
45 

entering information for poll officials, 45 
finance forms, 6, 64 

G 

GST, 7 

H 

Harmonized Sales Tax (HST), 7 
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L 

lease agreement for polling sites, 10 
leases for polling sites, 27 
leases for revisal offices, 27 

M 

management of budgeted hours 
Budget vs. Actual Worked report, 39 
recording approved additional hours, 41 
request additional hours, 40 
summary of budget activities, 41 
transfer hours between positions, 39 

methods of payment 
by cheque, 13 
direct deposit, 11 
pay statements, 13 

O 

office staff pay periods, 17 

P 

pay periods 
for office staff, 17 
for polling day workers, 18 

pay statements, 13 
payment by cheque, 13 
payment rules, 19 

35 hour rule, 19 
Canada Pension Plan, 20 
Employment Insurance, 20 
federal and provincial income tax, 19 
Quebec Pension Plan, 20 
record of employment, 22 
Relevé 1 slip, 22 
source deductions, 21 
T4 slips, 21 

payments for polling sites rental, 10 
polling day workers pay periods, 18 
polling sites 

lease agreement, 10 
payment for rental, 10 
rental fee increase, 10 

positions with fixed rates of pay, 14 
positions with hourly rates of pay, 13 

Positions-Budget vs. Actual Worked 
report, 39 

procedures, 25 
administration of purchases, 51 
confirmation of polling day activities, 43 
finalizing payments in ROPS/SITES, 45 
management of budgeted hours in 

ROPS/SITES, 39 
processing of lease agreements, 27 
recruitment of personnel and 

registration in ROPS/SITES, 31 
ROPS/SITES decommissioning, 55 
staff training, 35 

processing of lease agreements 
AARO office lease, 27 
leases for polling sites, 27 
leases for revisal offices, 27 
RO office lease, 27 

progress report on recruitment, 31 
progress report on staff training, 38 
Provincial and Territorial Sales Taxes 

(PST), 7 
purchases and rentals, 7 

authorized methods of payment, 8 
taxes, 7 

Q 

Quebec Pension Plan (QPP), 20 

R 

rates of pay for election workers, 13 
positions with fixed rates, 14 
positions with hourly rates, 13 

Record of Employment, 22 
recruitment of personnel and registration 

in ROPS/SITES 
information gathering, 31 
progress report, 31 
registration in ROPS/SITES, 32 

registration in ROPS/SITES 
of office workers, 32 
of poll officials, 33 
of revising agents, 33 

Relevé 1 slip, 22 
rental fee higher than prescribed, 10 
rental of RO and AARO offices, 9 
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report preparation calendar, 23 
Returning Office Payment System and 

SITES, 5 
RO office lease, 27 
ROPS/SITES, 5 

decommissioning, 55 

S 

source deductions summary, 21 
Special Account form, 8 
staff training 

after each session, 36 
before the session, 35 
during the session, 36 

preparation of data, 35 
progress report on training, 38 

statutory reports, 23, 65 
preparation calendar, 23 

submitting Special Account Form to EC, 
54 

T 

T4 Slips, 21 
tavel expenses, 16 
training fees, 15 
travel allowance, 15 
travel expenses, 16 
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